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Introduction

This compendium provides summarised procedures for setting up, operating and analysing data generated
from the ABI PRISM® 7700 Sequence Detector. It is intended to get you up and running quickly as well as
answer some commonly asked questions. Please refer to your ABI PRISM® 7700 Sequence Detection
System Users Manual for more detailed information.
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Materials and Methods

You should be amplifying your DNA template with your specific primers and TagMan fluorescent probe
using the TagMan Universal PCR Master Mix (Part No. 4304437). This is supplied in 2 x concentration
and contains heat-activated AmpliTag Gold DNA Polymerase, AmpErase UNG for carryover prevention,

dNTPs with dUTP, Passive Reference dye, and optimised buffer components.

Working Reagents

TagMan Universal PCR Master Mix 2 x stock

Forward primer 9 uM (see (b) below)

Reverse primer 9 uM (see (b) below)

TagMan probe 2.5 pM (see (a) below)

Water ddH,0 or MQ

DNA sample 2-20 ng/pl (gDNA, cDNA) or 10°-10" targets/l (clones)
Equipment

1. Optical tubes (N801-0933), caps (N801-0935) or 5. Setup racks
Adhesive covers (4313663)

2. Eppendorf tubes 6. Pens
Pipetmans: P20 and P200 7. Gloves
4. Pipette tips: filter-tipped 10—200 pl 8. Benchtop microcentrifuge

Precautions

Use accurate pipetting technique
Wear gloves when handling all reagents and tubes to avoid contamination
Filtered tips should always be used to avoid aerosol contamination

If possible, use screw cap (O-ring) sealed tubes for all primers, probes and stock nucleic acid solutions to

guard against possible cross contamination when opening tubes
Discard all used tips, tubes and gloves into the pathological waste

Keep tubes on ice
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Setup Protocols

(a) Probe dilution

1.
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Your TagMan probe is usually supplied as 60 pl of a 100 uM solution (confirm this on your Probe
specification sheet) and must be diluted to a 2.5 uM working reagent.

Pipette 30 pl into each of 2 screwcap tubes.

Add 1.17 ml of ddH,O to each of these tubes.

Close cap, mix by inversion 2—-3 times and spin briefly.

Pipette 120 pl aliquots of your working probe reagent into 20 x 1.5 ml tubes.

Store these probe aliquots at —70°C.

(b) Primer dilution

1.

Your primers are supplied desiccated and must be diluted to 9 uM for use as working reagent.
(The primers final concentration will be 900nM after pipeting out your Mother Mix volumes)
Resuspend each primer separately in 100 pl of ddH,O. For example, if you had 10,000 pMol of primer
it will now be at a concentration of 100 uM. Calculate the concentration of your solutions.
Using the following example calculation, you will need to add X ul of your resuspended primer in a
total of 150 pl of ddH,O:

X ul = final vol (ul) x final primer stock (UM) = 150 yl x 9 uM =13.5ul

primer yield (pMol) / resuspend vol (u)* (10,000 pMol / 100 pl)*

*Substitute your concentration following resuspension in 100ul of ddH,O (from 2. above)

Now mix X pl of your primer with (150 — X') pl of ddH,0O.
Repeat this process for your second primer.
You will now have one 150 pl aliquot for each of your primers for immediate use. The remaining

concentrated stock primer solutions can be left for you to take away with you and store at -70°C.

(c) Sample Dilution Series Preparation

1.
2.
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Label 5 Eppendorf tubes with your name and number them 1 to 5.

Pipette 45 pl of ddH,0 into each tube and stopper each tube (to prevent contamination by aerosols
from more concentrated solution).

Pipette 5 pl of your stock DNA template into tube #1. This is your first ten-fold dilution.

Mix carefully and spin solution down for 5 seconds in a benchtop microcentrifuge.

Pipette 5 pl from tube #1 into tube #2.

Mix and spin tube #2. This is your second ten-fold dilution.

Continue this process until tubes #3 and #4 have had DNA added. Leave tube #5 free of DNA (add
water only) as this will be used for your No Template Controls (NTCs).

Leave these samples on ice until needed.
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(d) PCR Setup

Assemble reagents in the rack provided. Thaw and mix any frozen reagents.

2. The 7700 plate will be set up complete with 8 rows of 12 tubes.

3. You will prepare duplicate tubes with the No Template Control (NTC) and each of your 5 dilutions

(total of X tubes). Prepare a PCR Mother Mix (MM) as follows:

Reaction Component X MM (ul) 13 x MM (ul) Final Sample Vol. (ul)  Final Conc.
TagMan Univ. PCR Master Mix (2x) 325 25 1x
Forward primer (9 puM) 65 5 900 nM*
Reverse primer (9 uM) 65 5 900 nM*
TagMan probe (2.5 pM) Fam 65 5 250 nM*
DNA sample - 5 -
Water 65 5 -

Total 585 50 -

* These are Applied Biosystems recommended Universal Concentrations but you should optimise
both the Primers and the Probe concentrations as outlined in the Master Mix Protocols

Prepare the mother mix for X x 50 ul samples as indicated in the previous table.

Pipette 45 pl of this mother mix to the bottom of each of X PCR tubes in the 7700-plate row or column
that you have been assigned.

Pipette 5 pl of water (No Template Controls) or DNA serial dilution sample as appropriate. Prepare

the NTC tubes first, followed by your dilution series in order of decreasing dilution (Dil.).

Row # Column #
1 2 3 4 5 6 7 8 9 10 11 12
Stock Stock Dil. Dil. Dil. Dil. Dil. Dil. Dil. Dil. NTC NTC

DNA DNA #1 #1 #2 #2 #3 #3 #4 #4 #5 #5

Seal tubes with the strip caps or a plate with an Adhesive Cover. The reactions are now ready for
thermal cycling. Optical Adhesive Covers can only be used with plates.

Put the 7700 plate into the 7700 Sequence Detector. Close the lid and click the run button.

The universal thermal cycling protocol is as follows:

Step Temperature (°C) Time
1. Carryover decontamination via UNG 50 2 min
2. AmpliTaq Gold pre-activation 95 10 min
3. Melting step 95 15 sec x 40 cycles

4. Anneal/Extend step (combined) 60 1 min
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Setup & Analysis of a TagMan® Run

Running the 7700 SDS

1.
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10.
11.

12.
13.
14.

The 7700 SDS must be switched on before the computer at least 30 min before run, but we recommend
leaving the instrument on at all times.

You must Re-Start the Mac computer before each run.

Double click on the Sequence Detector 1.7 icon.

Open new plate (under “file”) if new plate hasn’t opened automatically.

Select Reporter Dye (Default is FAM, so this step isn’t necessary if using FAM). If you are multiplexing

(also using VIC) a second Dye layer must be set up.

Label plate —i.e. NTC, Standards, Unknowns
* Todo this, select cells and then select label found under “Sample Type”.
* Also label cells with a “Sample Name”.
» Type in “Quantity” (necessary for standards).

» Can also specify if samples are “Replicates” (see page C-6 of User Manual).

Go to “Thermal Cycling Conditions”.
»  Specify Extension conditions.
e Specify Reaction volume.
* Goto “Show Data Collection” — collect all Data points.
*  Must always have 50°C for 2 min (Activation of UNG) and 95°C for 10 min (Activation of
AmpliTaq Gold and deactivation of UNG).

Add a “Comment” as to what the run is about.
“Save Plate” (“Save As” found under “File”).
Click on “Show Analysis” to view the Analysis screen.

"«

If using an Adhesive Cover go to “Instrument”,

"«

Diagnostics”, “Advanced Options” and select the
checkbox — “Set 7700 Exposure Time for Plates” and change the time from 25 to 10 (Very Important).
Place sample tubes or plate in 7700 SDS.

Press “Run” (when cover temp reaches 105 °C, the 7700 will beep & you will hear the shutters open).
“Time Remaining” of run is displayed on the screen.
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7700 Data Analysis

When the run has finished, Save your Data immediately.
Analyse Data (under “Analysis”). To View Data you must always be in the Analysis screen.

Select wells to view & go “Analysis” & select either “Amplification Plot”/“Standard Curve” etc.

> wnh =

Curves can be viewed in either log or linear form. Double click on the y-axis to change this view.

5. ltis also possible to re-label samples as standards after a run is complete:
* Goto “Set-up Screen”.
* Re-label samples as standards.
e Give each sample a quantity value— very Important!
* Go back to “Analysis” screen and re-analyse data.

* Now it is possible to quantify unknown samples compared to the nominated standards.

6. Make sure for complete and correct analysis of data: Use the OBT Principle!

* O: Exclude Outlying wells (wells that have failed) by going to “Edit” then “Clear”. Outliers are
best viewed on a linear amplification plot. It is also easy to detect outliers in the Ct vs. well
position view of the data. Exclude any samples that produce atypical plots or that “creep”, i.e.
that do not exhibit bona-fide amplification (defined as having 3 points in the log phase). This may
include NTCs that creep up over the threshold at 40 cycles.

* B: Set Baseline— Default range is 3 to 15. Set it to cover as many cycles as possible, typically
1-2 cycles before the reporter dye signal begins to increase. If amplification occurs after cycle
15 we do not recommend changing the baseline. The 13 data points within that range are
sufficient for the baseline. It should only be changed when amplification occurs before cycle 15.

« T:. Set Threshold Bar to the halfway point in the linear part of the amplification plot. Thresholds
are best set using the semi-log scale (this makes the linear phase of the PCR clear). A threshold
for a particular assay can be set to the same value from run-to-run (but this must be checked).

e If Multiplexing (Fam + Vic) go to “Instrument”, “Diagnostics”, “Advanced Options” and select

the checkbox— “Use Spectral Compensation for Real Time” and re-analyse.

Once you are happy with the Data go to “Window”, “Experimental Report” and print out results.
This Report contains sample Ct values, sample quantity and standard deviations.
To see any abnormalities of the run (if it was aborted or no standards were labeled, for example) go to

“Event Log” under “Window”.
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Trouble-shooting, Tips and Important User Maintenance

. Back up Data— Results should be regularly saved to a ZIP disk to avoid an eventual crash.

e Go to the SDS Runs Folder (This entire SDS Runs Folder should be deleted monthly).
» Files without Fluorescent icon can be copied onto ZIP and then deleted from this folder.

» Files with fluorescent icons are the responsibility of users and should be backed up.

7700 thermal cycler block must be kept clean — use 70% EtOH and cotton buds to clean.

Do not use any Organic Solvents or Radioactive samples in the 7700 SDS.

Mac Preferences (All under Apple, Control Panels — These must be set correctly)
 Energy Saver — set to Never
* General Controls — Shut Down Warning “Not Ticked” and Documents set to “Folder that is set
by the application”.
*  Memory — Virtual Memory must be “OFF”.

Rebuild the Mac desktop weekly by holding down Apple & Option Keys & Select Re-Start. Hold down
both keys until this message appears; “Do You Want To Rebuild the Desktop?” — Click OK.

To take a “Picture” — Hold down the SHIFT + APPLE + 4 keys. The cursor becomes a crosshair. You
can them lasso any part of the screen. When you release the mouse button you will hear a camera click.

A picture has been saved to the hard disk. Find Picture 1 on hard drive. This can be used for data

presentation or attached to an email for support (to |JABOZSupport@appliedbiosystems.com)|

Occasionally you will NOT be able to Analyse a run because the link between the raw data file and the

run file have been lost. You must do the following:

»  After quitting out of the SDS 1.7 software, double-click on your HD, go to System Folder,
Preferences, SDS and you will find a file labeled SDS preferences — drag this to the trash and
empty it (Be careful NOT to trash the Spectra Components folder).

« Open up the SDS 1.7 software and select File, New Plate making sure you select the correct
preferences for your specific application (i.e. the run that just finished).

* VERY IMPORTANT - You must re-setup a fresh plate exactly as you had labeled your previous
plate and that includes dual dye layers if you were using Fam and Vic.

e Then go File, Import, LabView Format Raw Data — you will be asked to assign the raw data file
from the run that failed to analyse properly.

* You must navigate to the SDS Runs f folder where the raw data files are located. The date and
time are stamped on these so it is very easy to get the correct one. A merging data icon will tell
you that all is successful.

* You can then analyse as normal but please save this plate immediately.
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Trouble-shooting, Tips and Important User Maintenance cont.

8. Norton’s Disk Doctor and Speed Disc should be run at least monthly via the Norton’s Utilities CD.

Insert Norton Utilities CD into the CD drive and do one of the following:

e Hold down the C key while starting up or

» Use the Startup Disk Control Panel to select the CD-ROM as the startup drive
(Different startup will depend on MAC OS and Version of Norton Utilities)

Go to “Special”, “Restart”

Double-click on the Norton Utilities CD

Double-click on the Norton Utilities Icon

Never Install Norton Utilities on your Hard-drive as it interferes with our software.

Click Norton Disk Doctor in the Norton Utilities menu

In the Disk Doctor window select your hard-drive and then click Examine
If you wish to save the report do so now or click cancel

Norton Disk Doctor will begin to test the selected drive

If any errors or recommendations are reported — select Fix

Click Done once finished checking your Hard-drive

If there were any fixes to be done you must again select your hard-drive and then click Examine until
you get a “No Problems Found” reported.

Go to “Utilities”, “Main Menu or Norton Utilities” and click Speed Disk
Click Ok

Choose your hard-drive to be optimised and click Optimize

When finished go “File”, “Quit”

Select “Special”, “Restart” if you used the C key to startup Norton Utilities or

Go to “Apple”, “Startup Disk” and select your hard-drive, then select “Special”, “Restart”
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Pre-Developed TagMan® Assay Reagents for MULTIPLEXING

Choosing Endogenous Controls for Normalizing Gene Expression

Using the comparative Ct method, endogenous controls can normalize the expression levels of target genes
by correcting differences in the amount of cDNA that is loaded into PCR wells.

Three steps are important in the endogenous control selection process:

1. Verify that the endogenous control is consistently expressed in the sample set to be tested.

Because the endogenous control normalizes differences in the amount of cDNA that is loaded into PCR
reaction wells, endogenous control expression must be uniform across all samples in the study.
Endogenous controls can be tested for uniform expression by comparing the gene expression of several
samples. Samples should be representative of the target's gene expression and should span the target's
expected range of expression. Specifically, it is important to demonstrate that while the target's expression
levels may range widely, expression of the endogenous control remains constant. When conducting this
test, it is crucial to load identical amounts of cDNA for each test sample. To ensure this, measure cDNA
concentrations spectrophotometrically. Gene expression of endogenous controls should vary only slightly.
The TagMan® Human Endogenous Control Plate (P/N 4309920) can evaluate 11 housekeeping genes for
their potential as endogenous controls. These 11 [endogenous controlg are also available as individual

reagents.

2. Ensure that the target(s) and endogenous control have identical PCR efficiency.

The endogenous control and target assays must have identical PCR efficiency. TagMan® PDARs (both
controls and targets) are carefully designed for optimal performance in gene expression quantification. It is
not necessary, therefore, to test PCR efficiency when using TagMan® PDAR controls for normalizing
TagMan® PDAR targets. However, when using TagMan® PDAR controls to normalize targets that are not
TagMan® PDARs, ensure that PCR amplification efficiencies are identical. This can be done by serially
diluting a cDNA sample and demonstrating that the C; difference between the target and endogenous
control remains constant. A constant Ct difference across a range of at least 3 logs (1000-fold) of initial

template concentration will verify identical PCR efficiency.

3. [Necessary for multiplexing only]: Ensure that the gene expression level of the endogenous control

is greater than that of the target.

An additional step is required for researchers who wish to multiplex an endogenous control and target on
the ABI PRISM® 7700 Sequence Detection System. PCR ampilification of the more highly expressed gene
must be primer limited. This guarantees that the less abundantly expressed gene will have adequate
resources during PCR amplification to achieve the maximum efficiency required for accurate quantification

results.

All TagMan® PDAR controls are primer limited and contain probes labeled with the VIC™ reporter dye. This
allows multiplexing of TagMan® PDAR controls with TagMan® PDAR targets, provided that the control gene

is more abundantly expressed than the target gene. To test that the control is more abundantly expressed
than the target, use test samples that span the expected range of target expression. It is important to run

separate control and target reactions for each sample. All control Cts should be lower than target Crs. If this

is not the case, two options are available: (1) Repeat Step 3, using another endogenous control, or (2)
Conduct the study by running the control and the target in separate wells.
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FAQsS

These are the top 16 Frequently Asked Questions from our Website

Description

Solution

1.What can be used to
dilute my TagMan® probe?

The probe can be diluted in 10 mM Tris-HCI, pH 8.0 (at room temperature); 1
mM EDTA or ddH,0.

2. Whenever | turn on the
7700, | get a Firmware
Incompatibility Error — How
do | stop this?

Applied Biosystems recommends leaving your 7700 Sequence Detection
System on at all times.

3. What are VIC labeled
probes?

Applied Biosystems designed the VIC dye as a replacement for the TagMan®
JOE dye currently in use with ABI PRISM Sequence Detection Systems. The
VIC dye features improvements in fluorescent signal strength, spectral
resolution, and production cost. VIC and JOE both have emission peaks at
554 nM. However, the fluorescent signal from VIC dye is nearly four times
stronger than JOE. The increased signal strength of VIC results in greater
sensitivity and, therefore, lower CTs at lower amplicon concentrations. VIC'’s
emission spectrum consists of a narrow peak with half bandwidth 15 percent
thinner than that of JOE. Consequently, the VIC spectrum overlaps less with
surrounding dyes and introduces less error into the system. Eventually, all
current kits that use Joe labeled probes will be replaced with VIC labeled
probes. The TagMan Cytokine Gene Expression Plate 1 (P/N 4304671) was
the first product released with VIC labeled probes. VIC labeled TagMan probes
are currently available in 40 nmole (P/N 450025), 0.2 mole (P/N 450024), and
1 mole (P/N 450003) scale DNA synthesis. For additional information on VIC
dye labeled TagMan probes refer to User Bulletin #5: Multiplex PCR with
TagMan VIC Probes (P/N 4306236).

4. If | want to do multiplex
PCR, how do | tell the
software that there are two
probes with different
labels?

Use the “Dye Layer” button from the set-up screen. E.g.: use FAM dye layer
for your target and VIC dye layer for the control target.

From the Sample Type Set-up menu, you need to designate acronyms with
the dye of choice. You cannot use the same acronym twice e.g.: if use “UNK”
with FAM then for VIC you need to designate “UNK-V”.

5. What'’s the best way to
ensure good
communication between
the Mac and 77007

A. Always re-start both the Mac and the 7700 before a new run.

B. Trash “SDS Preferences” once a week or whenever there is a lockup.
C. Re-build Mac desktop once a week

D. Run Norton’s Utilities once a month

6. Which dye label should |
use for my target and
control?

Always choose FAM for your target of interest as all of our Controls and
PDAR'’s are labeled with VIC.

7. Now that my probes
have arrived, what's the
first optimisation
experiment | should
perform?

Providing you are using our Universal Master Mix and Universal Cycling
conditions their will only be two (2) optimisation experiments required.

A Primer concentration matrix (50, 300, 900 nM of each primer) and a Probe
concentration titration (50, 100, 200, 250 nM)

Choose the concentrations, which give the smallest Ct value and largest delta
Rn.

8. Can | use 25ul reactions
instead of 50ul?

The instrument performance specification is based on 50ul reactions but 25ul
is possible. Smaller volumes are not recommended due to difficulties in optical
detection of very small volumes.

Remember to change the reaction volume in the cycler setup so that the 9600
cycler knows what the thermal load is.

9. Do | really need to use 8
of each control for my
Allelic Discrimination
Assay?

YES: if the automated allele calling routine in the software is to function
correctly 8 replicates of each type (NTCs, Allele#1 and Allele#2) are required.
This gives a 99.7% confidence level.

Manual allele calling with less replicates is possible but confidence is reduced
and that is why it is not recommended.
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10. In the TagMan® The control RNA is total RNA isolated from mouse.
Rodent GAPDH Control
Reagents (P/N 4304104)
kit, what rodent is the
Control RNA isolated from?

11. What is Baseline? The Baseline default is cycles 3 to 15.

It is used to calculate the “background” of un-reacted probe. It is very
important to shorten the Baseline when the samples become positive before
cycle 15 or the plot will be artificially “skewed” in a negative direction.

12. Can the ABI Prism Yes, but during data collection the AppleTalk should be turned off. If the
7700 Sequence Detection network communicates with the Mac during data collection the run will crash.
System Computer be
hooked up to a Network

using AppleShare?
13. How do | use Primer Primer and probe sets for TagMan can be designed by using an easy to follow
Express for designing tutorial for Primer Express, which is located at the following URL.:

primer and probe sets for http://www.appliedbiosystems.com/techsupp/tutorials/tagman]|
TagMan?

14. What extensions are No extensions are required to run the SDS software. The SDS software will
required to run the ABI work with all the extensions turned off.

Prism 7700 Sequence
Detection System?

15. Can Macintosh Below is a compatibility list of Macintosh Computers and Operating Systems
computers that are tested with the 7700s and 7200s:
connected to 7700s or PowerMac 7200 and Power Mac 4400 are compatible with Mac OS 7.6.1 and

7200s, running MAC O/S Mac OS 8.0; PowerMac G3 is compatible with Mac OS 8.0 only. Note: Mac OS
7.6.1, be upgraded to Mac | 8.1 is not supported and should not be used on the Mac to run the 7200 and
O/S 8.07? 7700 Sequence Detection Systems. A bug in Mac OS 8.1 can render the
7200s and 4400s inoperable.

16. What are the Molar Extinction Coefficients for the TagMan® dyes, when using a spectrophotometer to
quantitate TagMan probe concentrations at 260 nm, as well as the Excitation and Emission wavelengths?

Dye Excitation Wavelength (nm) Emission Wavelength (nm) Extinction Coefficient

FAM 488 518 20,958

VIC 488 552 30,100

TET 488 538 16,255

JOE 488 554 12,000
TAMRA 488 582 31,986

SYBR 488 520 N/A

ROX 488 610 N/A
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Primer Express 1.5 User Guide

Note - The following procedures are valid only for version 1.5 of the Primer Express software. Primer
Express is optimised for use with Applied Biosystems assays, consumables, probes, instrumentation,
reagents, and thermal cycling parameters. Melting temperatures may differ substantially if another Tm
calculator is used to design the TagMan probes or TagMan MGB probes.

TagMan Probe Design Guidelines

IMPORTANT - When designing probes, it is important to consider probes from both strands.
For designing TagMan probes, follow the guidelines below in order of priority:

1. Avoid probes with a guanine residue at the 5 end of the probe. A guanine residue adjacent to the reporter
dye will quench the reporter fluorescence, even after cleavage.

2. Select probes with a Primer Express software—estimated Tm of 68—70°C.

3. Make TagMan probes as short as possible without being longer than 30 nucleotides.

4. Avoid runs of an identical nucleotide. This is especially true for guanine, where runs of four or more should
be avoided.

TagMan Primer Design Guidelines
After selecting probes for the assay, choose primers based on the guidelines below, again in order of priority.

Consequently, amplicons are usually 75-150 bp. By limiting the parameters for amplicon design (such as
amplicon size), it is possible to run all reactions with a single reaction buffer (such as TagMan ® Universal
PCR Master Mix (P/N 4304437) and a single thermal cycling protocol.

1. Avoid runs of an identical nucleotide. This is especially true for guanine, where runs of four or more should
be avoided.

2. Set a Primer Express software—estimated Tm for the primers of 58-60°C.

3. Keep the guanine + cytosine content within 20-80%.

4. Make sure the last five nucleotides at the 3" end contain no more than two guanine + cytosine residues.

5. Place the forward and reverse primers as close as possible to the probe without overlapping it.

Please see the Applied Biosystems Amplicon Design Sheet 1.1 for more details
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Importing a Sequence and Marking Regions of Interest for Probe and Primer Design

The steps involved in importing a DNA sequence into the Primer Express software and subsequent design of
appropriate primers and probe are as follows:

1. Launch the Primer Express software.

To select a probe from... Then...

a DNA file a. From the File menu, scroll to New, and select TagMan Probe &
Primer Design. A TagMan Probe document appears.

b. Click Import DNA File.

c. Locate and select a DNA file in the browser.

d. Click Open (Try to limit the sequence too less than 1000 bp).

The software loads the sequence and displays it in the Sequence tab.
An existing primer/probe a. From the File menu, select Open. The Document Archive box
document (located in the appears.

Document Archive) b. Double-click the document to load, or select the sequence and click
Open.
The software loads the sequence and displays it in the Sequence tab.
a text document or a. Select the sequence from the text document or the navigator window.
GenBank sequence b. From the Edit menu, select Copy.

c. From the File menu, scroll to the New submenu, and select TagMan
Probe & Primer Design. A TagMan Probe document appears.

d. From the Edit menu, select Paste. The software pastes the nucleotide
sequence into the Sequence tab.

Note - Edit the GenBank sequence before saving it as a Primer Express
document.

3. In the “Sequence” view (see diagram below), the following checkboxes should be checked prior to primer
selection:

0 Double Stranded
Q Limit 3" G+C (You will have to de-select if the PEX software comes up with No Primer Pairs
Found or manually lock in your own)

=TagMan® Prohe #1

Primers T Map T Recipe T Results ]

| [_import DNa File.. ] [ Help ]

to E Couble Stranded E Lirnit 5" G+C

||||||||||||||||||||||||T||||||||||||||||||

The sense and antisense sequences appear on the Sequence tab when the “Double Stranded” checkbox is
selected.

4. Label any Intron/Exon boundaries within the sequence using the Junction tool:

a. From the Tools palette, click the Junction Tool.

b. Select the Intron/Exon sequence (i.e. the 2 bp spanning the Intron/Exon boundary).
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TCNANACGAC NCACTANTAG GGCGAATTCG AGCTCOGTAC CCOGGGATCC
TCTAGAGTCA GACCTGLAGG CATGAAGCTT GAGTATTCTA TAGTGTCACC
TAAATAGCTT GGCGTAATCA TGGTCATAGC TGTTTCCTGT GTGAAATTGT
TATCCGCTCA CAATTCCACA CAACATACGA GCCGGAAGCA TAAAGTGTAA
AGCCTOGEAT GCCTAATGAG TGAGCTAACT CACATTAATT GCGTTGCGCT
CACTGCCCGE TTTCCAGTCG GGAAACCTOT COTGCCAGCT GCATTAATGA
ATCOGCCAAC GCOCGOGOAG AGGCGOTTTG CGTATTGGGC GCTCTTCCGC
TTCCTCGCTC ACTTGACTCG CTGCGCTCGG TCOTTCGGCT GCOGCGAACG
GTTATCAGCT CACTCCAAAG GCGGTAAATA CGGTTTATCC ACCAGNATCA
AGGGGOATAA CCNCAGNAAA GAACATGTGA GCNAAAAGGN CAAGCAAAAG
GGCCAGG

5. Exclude any sequence where you DO NOT want primers/probe designed by using the Exclude tool:

a. From the Tools palette, click the Exclude tool.

AR
Exaziude

b. Select the excluded sequence, i.e. where you DO NOT want primers to be designed.

2@
168
158
200
230
300
330
400
450
G100
a7

THCG-AGCTCGGTA—CCREEGATEL

AGCCTGOGET GCCTAATGAG TGAGCTAACT CACATTAATT GCGTTGCGCT
CACTGCCCGC TTTCCAGTCG GGAAACCTGT CGTGCCAGCT GCATTAATGA
ATCGGCCAAC GCGCGGGGAG AGGCGGTTTG CGTATTGGGC GCTCTTCOGC

TTCCTCGCTC ACTTQACTCG CTGCGCTCGO TCGTTCOGCT GCOGCOAACG

5@
168
158
200
230
300
330
400
450
G100
a7
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Designing the TagMan Probe

Steps involved in the design of a TagMan probe are as follows:

6. Select the “Params*” Tab and select the “Factory Defaults button:

Note — Very Important to do! This resets the default parameters each time you are designing an assay. It is
very important if the PEX software is on a network as the values may be different from their defaults.

]

TagMan® Probe #1

Sequence | Params TRJ{H Cond T Primers T

Map

T Fecipe T Fesults ]

Primer Tm Requirements

Min Tm

Max Tm

Maximal Tm difference

Primer GC Content Eequirements

Min %G6C Max %GC 3 GCclamp | @) residues

Primer Length Requirements

Min length [ 9] Max length Dptimal length

Amplicon Requirements

Min Tm

Max Tm

Optimal Tm

Min length Mas length

TaqMan® Probe Criteria

TagMan® Probe Tm must be

[< TagMan® Probe should not begin with &

greater than PCR Primer

[ Mare Farams

) (

Lefaults

] [ Factory Defaults ] [

Help ]

Click the Sequence Tab, followed by “Options” and then “Find Primers / Probes Now”.

The PEX software will aim to design a Probe over the Intron/Exon boundary that you designated.

AGCCTGOGAET
TCGOACCCCA

GCCTAATGAG
COGATTACTC

CACTGOCCGC

TTTCCAGTCG

GTGACGGGCG

JCGGCCAAC

AMMGG TCAGC

GCGCGGLGGAG

AGCCGGETTG

CGEGCCCCTC

TTCCTCGCTC
AAGOAGCGAG

P &

ACTTGACTCG
TOAACTGAGC

&

TOAGCTAACT
ACTCOATTGA

GGAANCCTGT
CCTTTGGACA

AGGCGGTTTG
TCCGCCAMMC

CTGCGCTCGG
GACGCGAGCC

& =

CACATTAATT
GTGTAATTAA

COTGCCAGCT
GCACGGTCGA

COGTATTGGGC
GCATAACCCG

TCGTTCGGET
AGCAAGCCGA

Aok ey g

GCGTrGr:Gcﬁ:
COCAACGCGA

GCATTAATGA
CGYAATTACT

GCTCTTCCGC
COAGAAGGCG

GCOGCLAAMCG
COCCGCTTGC

— o=

206

250

306

358

406

450

& total of 47 primer pairs found. To examine primer pairs, click the ‘Frimers’ tab.
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In this example, the PEX software has come up with a list of 47 assays. These are temporary and the
maximum (default) is 200. You now need to interrogate all primers and the probe selections individually until
a final list of 1 assay is displayed meeting all guidelines.

8. Click the Primers Tab and scroll across to the TagMan Probe column:

SequenceT Params TFixn Cond TPrimers T Map T Recipe T Results ]
TaqMan® Probe Reve
Start Length Tm WHC Probe Start Length Tm &
Chy 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 312 20 59 =]
C 2568 22 59 &4  TCGGG A4 ACCTGTCGTGCC AGC 312 20 59
Chy 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 312 20 59
Chy 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 312 19 58
Chy 2568 22 59 &4  TCGGG A &ACCTGTCGTGCC AGC 312 19 58
Chy 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 312 19 58
CC A 2568 22 59 &4  TCGGG A &ACCTGTCGTGCC AGC 312 20 59
CC A 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 312 20 59
CC A 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 312 20 59
CC A 2568 22 59 &4  TCGGG A &ACCTGTCGTGCC AGC 312 19 58
CC A 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 312 19 58
CC A 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 312 19 58
Chy 2568 22 59 &4  TCGGG A &ACCTGTCGTGCC AGC 313 16 &0
Chy 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 313 16 &0
Chy 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 313 16 &0
CC A 2568 22 59 &4  TCGGG A &ACCTGTCGTGCC AGC 313 16 &0
CC A 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 313 16 &0
CC A 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 313 16 &0
1T 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 312 20 59
1T 265 23 59 &1 CAGTCGGG AMACCTGTCGTGEC & 312 20 59
1T 265 24 o 6% CAGTCGGG AMACCTGTCGTGEC AG 312 20 59
1T 2568 22 59 &4  TCGGG A &ACCTGTCGTGCC AGC 312 20 59
1T 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 312 20 59
Chy 2568 22 59 &4  TCGGG A &ACCTGTCGTGCC AGC 314 15 59
Chy 2569 22 (=25 &4  CGGGAAHAMCCTGTCGTGCC AGCT 314 15 59
Chy 2568 23 o &1 TCGGGAA4ACCTGTCGTGCC AGCT 314 15 59
1T 268 22 59 &4 TCGGG A AACCTGTCGTGCC AGC 32 19 58 -
1T 265 24 o 63 CAGTCGGG AAACCTGTCGTGCC AG 32 19 58 | |
1T 265 23 59 &1 CAGTCGGG AAACCTGTCGTGCC & 32 19 52 -
[T [4]»
|:| [ Order... ][ Sawe List... ][ ][ Help ]
& total of 47 primer pairs found. Click any entry in the list to select it. Details in Primer Data window,

Select the Probe from the list that satisfies all requirements from Page 12 and our SDS Amplicon Design
Sheet 1.1. Note - The Probe can be Top or Bottom strand depending on the “More C’s than G’s guideline”.

Note — The Probe/Primer List is ranked according to a Penalty Score (see Appendix B of the PEX User
Manual) from Top to Bottom (i.e. The lower the score the better). Penalty scores are calculated during
amplicon assembly, and are used to dynamically select the best 200 amplicons from among all possible
amplicons. Penalty Score is displayed on the Primers page in the column at the far right (you must scroll to
the right to view the penalty score).

9. Click on the Sequence Tab again and select the Probe Tool:

a. From the Tools palette, click the Probe Tool
Frobe

b. Then select the sequence designated inside the . If successful, the Probe sequence will turn
and lowercase.
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AGCCTGGGET
TCGGACCCCA,

GCCTAATGAG
COGATTACTC

CACTGCCCGC

TTTCCEEtcg

GTGACGGGCG

TCGGCOAAC

AMNGGTCage

GCGCGGGGEAG

AGCCGGTTG

CGICGCCCCTC

TTCCTCGCTC
AAGGAGCGEAG

ACTTGACTCG
TGEAMNCTGAGC

TOAGCTAMCT
ACTCGATTGA

ggaaoacctgt
cktttggoca

AGGCGGTTTG
TCCGQCCAMNT

CTGQCGCTCGG
GACGCGAGCC

CACATTAATT
GTGTAATT AN

cgtgccagc|l
gcocggtcgh

CGTATTGGGC
GCATAMCCCG

TCGTTCGGCT
AGCAAGCCGA

GCGTTGCG#}

COCAMCGCGA,

GCATTAATGA
CGTAATTACT]

GCTCTTCCGC
CGAGANGGCG

GCGGCGANCG
COCCOCTTGC

S@

1@E

15@

ZE@E

25@

3EE

350

45@

17

& total of 47 primmer pairs found. To examine primer pairs, click the 'Primner=s" tab.

10. Again select “Options”, then “Find Primers / Probes Now” from the drop-down menu.

11. The PEX software will now design forward and reverse primers that are most compatible with your
chosen probe sequence.

AGCCTGGGGET
TCOGACCCCA,

GCCTAATGAG
COOATTACTC

ICACTGCCCGC

TTTCCAS teg

GTGACGGGCG

JTCGGCCAAC

AAMGGTCogo

GCGCGGGGAG

AGCCGGTTG

CGIGCCCCTC

TTCCTCGETC
ALGOAGCGAG

ACTTGACTCG
TOAACTGAGC

TGAGCTALMCT
ACTCGATTGA

ggooocctgt
ctttggocao

AGGCGGTTTG
TCCGQCCAMNC

CTGCGCTCGG
GACGCGAGCC

CACATTAATT
GTOTAATTAR

cgtgccagoT
gcacggtocgi

COQTATTGGGC
GCATAMCCCG

TCGTTCGGET
AGCAMNGCCGA

GCGTTGCGL
CGCAACGCGA

GCATTAATGA
CGIAATTACT

GCTCTTCCGC
COAGAMGGCG

GCGGCGAACG
COCCGETTGC

S

le@

15@

26@

25@

36E

356

45@

& total of 25 primer pairs found. To examine primer pairs, click the ‘FPrimers" tab.

Note — There are now only 25 primer pairs compared to the previous 47.
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12. Click the Primers Tab again and scroll across to the Forward Primer column:

Select the Forward Primer sequence from the list that satisfies all requirements from Page 1 and our SDS
Amplicon Design Sheet 1.1.

Sequen:ET Params Tﬁxn EnndTPrimersT Map T Recipe T Result:

Forward Primer Ta

Start Length Tm BGC Primer Start Length Tm A E
230 17 bt 59 TCACTGCCCGCTTTCCA 268 22 &9 1
230 17 bt 59 TCACTGCCCGCTTTCCA 268 22 &9 1
249 18 39 51 CTCACTGCCCGCTTTCCA 268 22 &9 1
249 18 a9 51 CTCACTGCCCGCTTTCCA 268 22 &9 1
230 17 a8 59 TCACTGCCCGCTTTCCA 268 22 &9 1
249 18 a9 51 CTCACTGCCCGCTTTCCA 268 22 &9 1
247 17 &0 55  CGCTCACTGCCCGCTTT 268 22 &9 1
230 17 b= 59 TCACTGCCCGCTTTCCA 268 22 &9 1
247 17 &0 £5  CGCTCACTGCCCGCTTT 268 22 &9 1
249 18 29 51 CTCACTGCCCGCTTTCCA 268 22 &9 1
247 17 &0 £5  CGCTCACTGCCCGCTTT 268 22 &9 1
247 17 &0 55  CGCTCACTGCCCGCTTT 268 22 =3 1
230 17 b= 59 TCACTGCCCGCTTTCCA 268 22 =3 1
249 18 29 51 CTCACTGCCCGCTTTCCA 268 22 =3 1
230 17 b= 59 TCACTGCCCGCTTTCCA 268 22 =3 1
249 18 29 61 CTCACTGCCCGCTTTCCA 268 22 = 1
247 17 &0 65  CGCTCACTGCCCGCTTT 268 22 = 1
207 24 29 S0  GGGTGCCTAATGAGTGAGCT AACT 268 22 = 1
207 24 29 S0  GGGTGCCTAATGAGTGAGCT AACT 268 22 = 1
207 24 29 S0  GGGTGCCTAATGAGTGAGCT AACT 268 22 = 1
207 24 a9 S0  GGEGTGCCTAATGAGTGAGCT AACT 268 22 a9 1
230 17 a8 59  TCACTGCCOGCTTTCCA 268 22 a9 1
249 18 a9 61 CTCACTGCCCGCTTTCCA 268 22 a9 1
207 24 a9 S0  GGEGTGCCTAATGAGTGAGCT AACT 268 22 a9 1
207 24 29 S0 GGEGTGCCTAATGAGTGAGCT AACT 268 22 &9 1

D [ Order... ][ Sawve List... ][ ][ He |p ]

& total of 25 primer pairs found. Click any entry in the list to select it. Details in Primer Data window .

13. Click on the Sequence Tab again and select the Forward Primer Tool:

a. From the Tools palette, click the Forward Primer Tool

—
Frotwr.
Primer

b. Then select the sequence designated inside the blue/red box. Once the mouse button is released, the
primer sequence will be underlined with a solid blue arrow.



AGCCTGGGGOT GCCTAATGAG
TCQGACCCCA COGATTACTC

E ACTGCCCGC TT1 ICC%itr_g
GTGACGGGEG A8MNGGTCogo

JCOGCCANT GCGCGGLGGAG
AGCCGGTTG CGIGCCCCTC

TTCCTCGCTC ACT TGACTCG
AAGOAGCGAG TGAMCTGAGC
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TGAGCTANMCT
ACTCGATTGA

ggaoacctgt
cotttggoco

AOGCGGETTTG
TCCGQCCAMNC

CTGCGCTCGG
GACGCGAGCC

CACATTAATT
GTGOTAAT T.AL

cgtgccagc|l
gcacggtocgi

COTATTGGGC
GCATAACCCG

TCGTTCGGCT
AGCAMGCCGA

GCG'I_I'GCGCEE:
CGCAMCGCGR,

GCAT TAANATGA
Cof AATTACT]

GCTCTTCCGC
COAGAMNGGCG

GCGGCGANMCG
CGCCGCTTGC

1@@

15@

2@

25@

3@E

35@

“aE

45@

& total of 25 primer pairs found. To examine primer pairs, click the ‘Frimers' tab.

14. Again select “Options” “Find Primers / Probes Now”

15. The PEX software will design reverse primers that are most compatible with the selected probe and
forward primer sequences:

Note — There are now only 7 primer pairs compared to the previous 25.

| IS T T Y T T T Y T G T Y Y Y Y Y T Y T N Y S Y T T T T T S Y T T Y N Y S T T T O T T T T N N T O T T T (T T T T B
B L e e e = L S e s R a@

1o

156

206

AGCCTGOGOT GCCTAATGAG
TCOGACCCCA COGGATTACTC

CACTGCCCGC T ICC%Gtr_g
GTOACGGOCG AMAGGTCogo

JTCGGECANC GEGCGGGGMAG
AGCCGGTTG CGIGCCCCTC

TTCCTCGCTC ACTTGACTCG
AAGGAGCGAG TGAACTGOAGC

TOAGCTAAMCT
ACTCGATTGA

ggooacctgt
ctttggoco

AGGCGGTTTG
TCCGCCAMMNT

CTGCGCTCGG
GACGCGAGCC

CACATTAATT
GTOGTAATTAL

cgtgoccago(T
gcacggtocgh

COGTATTGGGC
GCATAACCCG

TCOGTTCGGCT
AGCAAGCCGA,

GCGTHECGC@:
CGCAACGCGA

GCATTAATGA
CGIAATTACT

GCTCTTCCGC
COAGAMGGCG

GCOGCGAMCG
COQCCGCTTGE

256

306

356

456

& total of 7 primner pairs found. To examine primmer pairs, click the 'Primers’ tab.
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16. Click the Primers Tab again and scroll across to the Reverse Primer column:

a. Select the Reverse Primer sequence from the list that satisfies all requirements from Page 1 and the SDS
Amplicon Design Sheet 1.1.

b. If possible, select the Reverse Primer that matches the Forward Primer in Tm — in this case, 58°C.

SEguence T Params T Rxn Cond T Primers T Map T Recipe T Results
e Reverse Primer

Probe Start Length Tm BGC Primer Lengt
AACCTETCGTGOC AGC 3z 20 59 45 GCGTTGGCCGATTCATTAAT 53
SACCTGTOGTGOC AGC A2 19 58 47  GCGTTGGCCGATTCATT &4 53
SACCTGTCG TG AGC 313 16 &0 63  CGCGTTGGCCGATTCA 5
SACCTETOG TGO AGC 314 15 59 &7 GCGCGTTGGCCGATT [t
SACCTGTEGTGEC AGC 243 18 58 S5 AGCGCCCAATACGEE & A AL Qe
SACCTGTOGTGLC AGC Fdd 18 59 56  GAGCGCCCA AT ACGE A A4 =L
SACCTETOG TGO AGC Fe0 19 59 53 GAGCGAGGEAAGCGEE & AGAG 111

(i
|:| [ Order... ][ Save List... ][ ][ Help ]
& total of 7 primer pairs found. Click any entey in the list to select it Details in Primer Data window.

17. Click on the Sequence Tab again and select the Reverse Primer Tool:

a. From the Tools palette, click the Reverse Primer Tool.

.‘_
Revietza
Prrmet

b. Select the sequence designated inside the blue/red box. If successful the primer sequence will be
underlined with a solid blue arrow.



SDS Compendium: 7700 - Ver. 3.0

AGCCTOGOGOT GCCTAATGAG
TCGGACCCCA COGATTACTC

EﬁETGCCCGC IIICC%GtEg
OGTGACGGGCG AMAGGTCogo

JCOGCCAMC GCGCGLGGLAG
AGCCGGTITG CGIEGCCCCTOC

TTCCTCGCTC ACTTGACTCG
AAGOAGCGAG TGAACTGAGC

TOAGCTAMCT
ACTCGATTGA

ggaoacctgt
cotkttggocao

AGGCGGTTTG
TCCGCC ALNT

CTGCGCTCGG
GACGCGAGCC

CACATTAATT
GTOTAAT T AL

cgtgccagol
gcaocggtocgh

COTATTGGGC
GCATANCCCG

TCGTTCGGCT
AGCAANGCCGN

GCGTrGCGcEr
CGCAACGCGHA,

GCAT TAATGA

)

GCTCTTCCGC
COAGANMGGCG

GCGGCGAMCG
COCCGCTTGC

15@

200

230

30

356

“HAE

456

SEE

& total of 7 primer pairs found. To examine primer pairs, click the ‘Primers" tab.

conforms to the recommended TagMan guidelines.

18. It is VERY IMPORTANT to select “Options”, “Find Primers / Probe Now* for a final analysis. The PEX
software will analyse the interaction of all 3 oligonucleotide sequences to determine if the combination

A successful design is designated by the message " A Total of 1 Primer Pairs Found." (See text at

the base of the Sequence view, below).

AGCCTGGGGET GCCTAATGAG
TCOQOACCCCA COGAT TACTC

EﬁETGCCCGC IIICC%GtEg
GTOACGGGCEG AAAGGTCagc

TCGGCOANT GCGCGGGGAG
AGCCGGTTG CGIEGCCCCTC

TTCCTCGCTC ACTTGACTCG
AAGGAGCGAG TGAACTGAGC

TOQAGCTANCT
ACTCOATTGA

ggaaoacctgt
cotttggoco

AGGCGGTTTG
TCCGQCC AN

CTGCGCTCGG
GACGCGAGCC

CACATTAATT
GTGTANT T AN

cgtgoccagoc|l
gcacggtocgh

COTATTGGGC
GCATAMNCCCG

TCOGTTCGGCT
ALCANGCCGA

GCGTTGCG@E

COCAnCGCGA
GCAT TAATGA

R

GCTCTTCCGC
COAGAMGGEG

GCGGCGANCG
COQCCQCTTGC

15@

200

250

Jae

350

HAB

456

SEE

& total of 1 primer pairs found., To examine primer pairs, click the ‘Primers" tab.
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19.

20.

a.
b.

21.

22.

You must see at the bottom of the document — A Total of 1 primer pairs found (not 2 or more).
This is a 100% Guaranteed Assay from Applied Biosystems providing:

The target sequence information is correct.
Applied Biosystems instruments, software, reagents and consumables are used to run the assay (the
guarantee does not extend to other manufacturers products).

There are two ways to save this final assay:

“File” then “Save As” is an internal save within the Archive File or

“File” then “Export” is an external save to the computer's hard-drive. You can send your assay to
Applied Biosystems - ABOZSupport@appliedbiosystems.com|for checking and confirmation by one of
our Field Application Specialists.

As a final check, all details on the SDS Amplicon Design Sheet 1.1 should be completed. In addition,
Applied Biosystems recommends that you do a BLAST search on your primers/probe to confer
specificity.

Primer Express Tips if the above instructions fail to design any primers

1.

Deselect the Intron/Exon boundaries with the Eraser Tool if the PEX software fails to come up with any
Primer pairs and use the Line Tool instead. You will then have to manually choose your own primers in
conjunction with the Exclude Tool to get the software to design some Primers in the area that you want.

Deselect the Limit 3' G+C checkbox if the PEX software fails to come up with any Primer pairs and
carefully choose a Primer from the Primers Tab that satisfies the “No More the 2 G/C’s in the last five
bases” guideline. If none choose the least number of G/C’s.

If you are still having problems, you will manually have to come up with Primers yourself. Use the Primer
Test Document to come up with a Primer that meets the correct Tm range (i.e. 58-60°C). Copy the
sequence and select “Edit”, then “Find Sequence”, paste in the sequence and select OK. The
sequence will be underlined in the Sequence Page so you can then lock it in with the respective
Forward or Reverse Primer Tool button to see if it passes. You may have to do this several times until
you come up with an acceptable primer.

If you are still having problems use new TagMan MGB Probe and Primer Design document. As the
probes are much shorter you should be able to come up with a list in the Primers Page. The rest of the
design is as standard.

When designing Primers for a SYBR Green assay, do exactly as outlined in pages 12-22 above, i.e. lock
in the probe and primers but don’t get the probe synthesised. This way if you need it later the probe is
ready to be synthesised.

Two final issues:

A — Use the Primer Express software for also designing standard PCR, RT-PCR and when designing
Sequencing Primers.

B — No matter what document you are using, remember to click on the Factory Defaults button
(Params Tab) before you start as well as locking in all relevant primers. You must get down to a final
list of 1 Primer Pairs found to be confident in the primers selected by the software.


mailto:ABOZSupport@appliedbiosystems.com
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Generating 7700 SDS Amplification Plots in a Spreadsheet Program

The goal of this tutorial is to demonstrate the procedure through which analyzed data generated within a
7700 data file can be exported & regenerated in Microsoft® Excel in order to generate an amplification plot.

**The following tutorial should be used as a guideline only. For further information on how to use Microsoft®
Excel and Chart Wizard, please refer to the Microsoft® Excel user manual. Applied Biosystems does not
support Microsoft® Excel or any other Microsoft® Software.**

Step 1: Manipulations within the 7700 software:

Open the SDS data file to be analyzed.
Analyze the data and set the baseline & threshold according to Applied Biosystems guidelines. To obtain

information on baseline & threshold setting, please refer to pages 23-32 in the TagMan Cytokine Gene

Expression Plate | Protocol, available on-line at: http://www.pebiodocs.com/pebiodocs/04306744.pdf

From the File menu, select "Export" and "Clipped data". You may either export all of the data or data
from selected wells (click the appropriate button).
The default file name will be "data.clipped"”. Provide a name and file location for this data. It is

suggested that you keep the suffix .clipped.

Step 2: Open a new Workbook in Microsoft Excel:

1.
2.

N o o k&~ W

©

10.

Select "File", "Open". Open the .clipped file.

Create a chart by either selecting "Chart" from the "Insert" tab, or by clicking the Chart Wizard button.
Select XY (Scatter) as the chart type, and select the Chart sub-type “Scatter with Data Points
Collected by Smoothed Lines”. Click "Next".

Select the "Series in: Columns" button. The Data Range will default to the entire chart. Click "Next".
Begin to format the plot by adding a title to the chart and defining the axes. Click "Next".

Save the plot either as a separate file or as an object in the current file. Click "Finish".

This is the rough plot as seen after clicking "Finish". The plot can now be formatted and adjusted.
Double-click on the X-axis to re-scale and Select Check Boxes: Minimum: 0, Minor Unit: 0.4 and Value
(Y) Axis Crossed at: 0. Patterns, font, and number notation can all be adjusted. Click "OK".
Double-click on the Y-axis to re-format. The formatting options are similar as to those for the X-axis.
Since Y-axis scaling is based on fluorescence values, it is important to note that this scale will be assay
dependent. Click "OK".

To convert the plot to the Logarithmic view, check the "Logarithmic" box while formatting the Y-axis.
Scales may need to be re-adjusted at this point. Click "OK". Your plot should be finished. Please go to:
Ivww . appliedbiosystems.com/techsupp/tutorial s'7700amp/[for the above tutorial.

Generating 7700 SDS Standard Curve Plots in a Spreadsheet Program

The goal of this tutorial is to demonstrate the procedure through which analyzed data generated within a
7700 data file can be exported and regenerated in Microsoft Excel. This tutorial demonstrates how to
generate a Standard Curve.

**The following tutorial should be used as a guideline only. For further information on how to use Microsoft®
Excel and Chart Wizard, please refer to the Microsoft® Excel user manual. Applied Biosystems does not
support Microsoft® Excel or any other Microsoft® Software.**


http://www.pebiodocs.com/pebiodocs/04306744.pdf
http://www.appliedbiosystems.com/techsupp/tutorials/7700amp/
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Step 1: Manipulations within the 7700 software:

Open the SDS data file to be analyzed.
Analyze the data and set the baseline & threshold according to Applied Biosystems guidelines. To obtain

information on baseline & threshold setting, please refer to pages 23-32 in the TagMan Cytokine Gene

Expression Plate | Protocol, available on-line at: pttp://www.pebiodocs.com/pebiodocs/04306744.pdf

From the File menu, select Export and Results. You may either export all of the data or data from
selected wells (click the appropriate button).
The default file name will be data.results. Provide a name and file location for this data. It is suggested

that you keep the suffix .results.

Step 2: Manipulations within Microsoft Excel:

o A W NP

10.

11.
12.
13.

14.
15.
16.
17.

18.

10.
20.
21.
22.

Open a new Workbook in Microsoft Excel.

Select File, Open and open the .results file.

Copy and Paste the Quantities and Ct values from this data into a new Worksheet.

Create a column between the Quantities column and the Ct column.

The Quantities need to be converted to their log values. To do this, click on the fx icon on the Toolbar.
Click on Math and Trig, and select Log.

Convert the quantities into their log values in the appropriate column. The log values will be displayed on
the x-axis and the Ct values on the y-axis.

Go to the Chart Wizard icon on the tool bar and click to open.

For the chart type, select XY (scatter) and select the chart sub-type Scatter. Compares Pairs of
Values. Click Next.

Chart Wizard now asks for a Data Range:

To select a data range, place your cursor at the top corner of the data points to be used. Click and drag
to highlight the data points. Include the data for both axes.

The data points will be plotted in the Chart Wizard. Click Next.

Click on the Titles tab and name the chart title and axes. Click Next.

Select a location for the chart. The chart can be created in a new sheet or within the current
spreadsheet. E.g. the chart will be created in the open spreadsheet. Click Finish.

To finish formatting, place your cursor on a point in the graph & click once to highlight the data points.
From the Chart tab on the menu bar, select Add Trendline.

Under the Type tab, highlight Linear.

Under the Option tab, select the Display equation on chart and Display R-squared value on chart boxes.
Click OK.

The chart should now display the equation, which may be moved by clicking on the equation and
dragging it to a new location.

To format the X-axis, point your cursor to the X-axis and click.

Font size, scales and patterns can also be changed in this view.

To Format the Y-axis point the cursor on the Y-axis and click.

Your Graph should now be finalised. The format can be changed via the menu bar in Microsoft® Excel.

Please go to: www.appliedbiosystems.com/techsupp/tutorial §'7700std/| for the above tutorial.



http://www.pebiodocs.com/pebiodocs/04306744.pdf
http://www.appliedbiosystems.com/techsupp/tutorials/7700std/
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ABI PrIsM 7700 SDS User Maintenance Schedule

To keep your ABI PRISM 7700 Sequence Detection System in peak operating condition, check the
following items at the interval recommended. Note observations in a logbook for future reference.

Daily Before Running

* Restart the Macintosh Computer before beginning SDS Software ver. 1.7

» Check that the optical caps are seated correctly in the tubes or plates

» Check that you have set up your plate correctly & each well is labeled correctly in the software

» If using an Adhesive Cover go to “Instrument; Diagnostics; Advanced Options” and select the
checkbox; “Set 7700 Exposure Time for Plates”. Then change the time from 25 to 10 (Very
Important)

After Each Run

» Use the “Save As” function immediately to Save your data
« Use “OBT principles to correctly analyze data (i.e. Remove Outliers; set Baseline; set Threshold)
* Remove the tubes or plate from the 7700 and discard accordingly

Weekly

* Rebuild Desktop on Macintosh by holding down the Apple and Option keys during startup
« Open the “System Folder; Preferences folder; SDS Folder” and you will find a file labeled “SDS
preferences” — drag it to the trash and empty it

Monthl

*  Wipe Perspex lid clean
» Update SAM virus definitions file
* Run Norton Disk Doctor and Speed Disk if available

Yearl

During the Annual Planned Maintenance visit, your Applied Biosystems Service Engineer will
perform those items listed in the monthly checks, and in addition:

» Check laser alignment and verify that the Thermocycler is working correctly

* Check CCD signal to noise ratio

» Clean interference filters and laser mirrors where necessary

» Verify the Optics system

» Check that safety interlocks operate, and that all safety labels are visible

* Remove dust from computer (inside and outside), clean screen and keyboard
* Run Verify Instrument test

e Perform all required upgrades

To Contact Customer Support: Phone: 1800 636 327 (Australia), 0800 446 416 (New Zealand
Email: abozsupport@appliedbiosystems.com
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